Experiment HP-1: Facial Electromyograms (EMG) and Emotion
Facial Electromyography (fEMG) refers to an EMG technique that measures muscle activity by
detecting the electrical impulses that are generated by muscle fibers in the face when they contract. It
primarily focuses on two major muscle groups, the corrugator supercilli and zygomaticus major muscle
groups.
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Facial EMG has been studied to assess its basis as a tool for measuring emotional reactions to various
stimuli. Studies have found that contraction of the corrugator muscle, which lowers the eyebrow and is
involved in frowning, varies inversely with the activity of the zygomaticus muscle, which controls
smiling. It is said these muscle groups are either associated with negative emotional stimuli and
negative mood (corrugator) or positive emotional stimuli and positive mood (zygomaticus). Facial
Electromyography is emerging as a more precise and sensitive method to measure changes in facial
expressions than just using visual observation. Facial EMG measures minute changes in the electrical
activity of facial muscles, which reflects minute muscle movements. This technique has been shown to
be capable of measuring facial muscle activity to even weakly evocative emotional stimuli. Even when
subjects are instructed to inhibit their emotional expression, facial EMG can still register the response.
Facial EMG has been used to distinguish and track positive and negative emotional reactions to a
stimulus as it occurs. Many of these experiments have been conducted in laboratory environments
using a range of stimuli, such as: still pictures, movie clips and music pieces.
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Another aspect of Facial EMG is the different emotional responses shown between males and females.
Analysis in a number of experiments has shown that compared to men, women reported higher feelings
of pleasantness and generated significantly higher EMG ratios at the zygomatic muscle region while
viewing pleasant images and women reported significantly fewer feelings of pleasantness and
generated significantly higher EMG ratios at the corrugator muscle region while viewing unpleasant
images. These results have demonstrated that gender plays a role in emotion expression and associated
EMG responses while viewing emotion provoking photographs.
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In this series of lab exercises, students will record and analyze facial EMGs using an iWorx A/D
recorder while looking at a variety of images known to produce emotional responses. Students will be
viewing still images, but this exercise can be extended to include both video and responses when
listening to music. This lab experiment is also fully customizable to add Galvanic Skin Response to the
data collection. This will allow students to observe a wider range of parameters to support the idea that
facial EMGs are a valid method for determining emotional response.
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Experiment HP-1: Facial Electromyograms (EMG) and Emotion
Equipment Required
PC or Mac Computer
USB cable
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IX-BIO4 or IX-BIO8 data recorder
Five EMG electrode lead wires
Disposable electrodes
Alcohol swabs

IX-BIO Setup
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Use the USB cable to connect the computer to the USB port on the IX-BIO.
Start the Software
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1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is
not available, click on the Windows Start menu, move the cursor to All Programs and then to
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window
will appear as the program opens.
2. On the Main window, pull down the Settings menu and select Load Group.
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3. Locate the folder that contains the settings group, IXBIO.iwxgrp. Select this group and click
Open.
4. Pull down the Settings menu again. Select the FacialEMG settings file from Human
Psychophysiology.
5. After a short time, LabScribe will appear on the computer screen as configured by the
FacialEMG settings.
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6. For your information, the settings used to configure the LabScribe software and the IX-BIO unit
for this experiment are programmed on the Preferences Dialog window which can be viewed by
selecting Preferences from the Edit menu on the LabScribe Main window.
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7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any
of the following documents:
•
•
•
•

Appendix
Background
Labs
Setup (opens automatically)
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EMG Cable Setup
1. Locate the red, black, green, brown, and white electrode lead wires and connect them to the
color coded sockets on the IX-BIO (Figure HP-1-S1).
2. Locate the muscles of the face over which the recording electrodes will be placed. Muscles can
be located by frowning and smiling and noting the areas of the face where the muscles are
tense.
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3. Use an alcohol swab to clean and scrub the areas where the electrodes will be placed. Let the
areas dry before attaching the electrodes.

Figure HP-1-S1: The IX-BIO4 with five EMG electrodes.
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Note: You will need to trim the snap electrodes carefully so they fit close together in each of the
locations. Trim them prior to removing the plastic backing.
4. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas.
Attach an electrode to each of the other areas.
5. One pair of recording electrodes will be placed over the Corrugator supercilli muscle just above
the left eyebrow.
The first electrode is placed above the eyebrow and directly in line with inside corner of
the eye. This sensor should be placed as close to the eyebrow as possible.

•

The second sensor is placed directly next to the first sensor and to the outside of the eye.
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6. The second pair of recording electrodes will be placed along the Zygomaticus major muscle
along the right cheek.
•

Trace an imaginary line between the corner of the mouth and the indentation at the top
of the ear. Place the first electrode directly in the center of this imaginary line.

•

Place the second electrode immediately next to the first, closer to mouth along the
imaginary line.

7. The fifth electrode, used as the ground, is centered on the subject’s forehead.
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Figure HP-1-S2: The positions of the electrodes on the face for recording Facial EMGs.
8. The positions of the electrodes are as follows (Figure HP-1-S2)

The red “+1” lead is placed near the center of the left eyebrow.

•

The black “-1” lead is placed immediately to the left of the red electrode towards the
outside of the eyebrow.

•

The brown “+2” lead is placed along the cheek midway between the ear and the mouth.

•

The white “-2” lead is placed adjacent to the brown electrode closer to the mouth.

•

The green “G” electrode is placed in the center of the forehead.
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Note: The electrodes must be placed very close together, trimming them will help keep them
positioned correctly.
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Experiment HP-1: Facial Electromyograms (EMG) and Emotion
Exercise 1: Muscles in Face used for Smiling and Frowning
Aim: To study the EMG activity in muscles of the face that work to smile or frown.
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Procedure

1. Instruct the subject that he or she will be doing the following during this exercise:

Before the recording begins, the subject will sit quietly with their mouth neither smiling
nor frowning. This position is defined as the neutral position.

•

Smile widely away from the neutral position and hold this position for four seconds
(Figure HP-1-L1).
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Figure HM-9-L1: Movement performed while recording from muscles of the face responsible smiling.
Note that the top channel (Corrugator s.) is not active while the subject is smiling.
Return the mouth to the neutral position for four seconds.

•

Frown and mouth to the neutral position for at least wo seconds.

•

Repeat this cycle two more times while recording.
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2. Before the starting the recording, type Neutral in the Mark box to the right of the Mark button.
Instruct the subject to place his or her mouth in the neutral position.
3. Click the Record button in the upper right corner of the LabScribe Main window. Click on the
Mark button to label the recording.
4. While the subject’s mouth is in the neutral position, type Smile in the Mark box. When the
subject smiles, click on the Mark button to label the recording.
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5. While the subject is smiling, type Neutral in the Mark box. When the subject returns his or her
mouth to the neutral position, click on the Mark button to label the recording.
6. While the subject’s mouth is in the neutral position, type Frown in the Mark box. When the
subject frowns, click on the Mark button to label the recording.
7. Repeat Steps 2 through 6 two more times.
8. When the last cycle is completed, click the Stop button.
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9. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure
HP-1-L2.

Figure HP-1-L2: Recording showing the movements when the subject is smiling and frowning.
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Data Analysis
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10. Select Save As in the File menu, type a name for the file. Choose a destination on the computer
in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click
on the Save button to save the data file.

1. Scroll through the recording and find the section of data recorded while the subject was smiling
and frowning.
2. Use the Display Time icons to adjust the Display Time of the Main window so three smilefrown cycles appear on the Main window. The three cycles can also be selected by:
•

Placing the cursors on either side of the three adjacent cycles; and

•

Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the
segment with the three cycles to the width of the Main window.
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3. Click on the Analysis window icon in the LabScribe toolbar (Figure HP-1-L3) or select
Analysis from the Windows menu to transfer the data displayed in the Main window to the
Analysis window (Figure HP-1-L4).

Figure HP-1-L3: The LabScribe toolbar.
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4. Look at the Function Table that is above the uppermost channel displayed in the Analysis
window. The mathematical functions, Abs. Int and T2-T1, should appear in this table. The
values for Abs. Int and T2-T1 on each channel are seen in the table across the top margin of
each channel.

Figure HP-1-L4: EMG activity from the muscles used for smiling and frowning. Cursors are placed to
measure the EMG activity taking place during the first “smile” episode.
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5. Once the cursors are placed in the correct positions for measuring the parameters of a smile or
frown, the values for the parameters can be recorded in the on-line notebook of LabScribe by
typing the names and values directly into the Journal, or on a data table.
6. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of the parameters to the Journal. To use these functions:
Place the cursors at the locations used to measure the absolute areas.

•

Transfer the name of the mathematical function used to determine the absolute areas to
the Journal using the Add Title to Journal function in the Zygomaticus major m. Channel
pull-down menu.

•

Transfer the values for the absolute areas to the Journal using the Add All Data to
Journal function in the Zygomaticus major m. Channel pull-down menu.
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7. Use the mouse to click on and drag the cursors to the onset and offset of the first smile (Figure
HP-1-L4). The values for Abs. Int and T2-T1 on the Zygomaticus major channel are the relative
amounts of the EMG activity and the durations of the zygomaticus muscle during the smile.

The values for these parameters, listed in the table above the Corrugator supercilli
channel, are the same properties from the corrugator muscle during the frown.
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8. Use the mouse to click on and drag the cursors to the onset and offset of the first frown. The
values for Abs. Int and T2-T1 on the Corrugator supercilli channel are the relative amounts of
the EMG activity and the durations of the corrugator muscle during the frown.

9. Record the values from each muscle during the first smile frown in the Journal, or on a data
table.
10. Use the mouse to move the cursors to onset and offset of the next smile. Measure and record the
values for Abs. Int and T2-T1.
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11. Use the mouse to move the cursors to onset and offset of the next frown. Measure and record
the values for Abs. Int and T2-T1.
12. Repeat steps 10 and 11 for the last smile-frown recording.
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13. Average the values for each parameter taken from the zygomaticus muscle during smiling. Find
the average for each parameter from the corrugator muscle during frowning. Enter the averages
for each parameter on Table HP-1-L1.
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14. Select Save from the File menu.

Questions

1. Which muscle had the most EMG activity during smiling?
2. Which muscle had the most EMG activity during frowning?
3. Did the subject notice the way the muscles moved during smiling and frowning. If so, what can
be commented upon about how these muscles move to accommodate smiling and frowning?
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Table HP-1-L1: Average EMG Activity and Duration during Smiling and Frowning
Smile
Smile
Frown
Frown
Abs Int (mV) Time (sec) Abs Int (mV) Time (sec)
1
2
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3
Mean

Exercise 2: Smiling and Frowning While Looking at a Variety of Images

Aim: To study the subject’s emotional response while looking at a series of images.
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Procedure

1. Instruct the subject that he or she will be doing the following during this exercise:
Before the recording begins, the subject will sit quietly with their mouth neither smiling
nor frowning. This position is defined as the neutral position.

•

The subject will then be shown an emotional or neutral image for a few seconds.

•

Based on the emotion felt while looking at the image - the subject will smile, frown or
leave the mouth in the neutral position.
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Note: It is important to have on hand a variety of images that express happiness, sadness, excitement,
surprise, agony, etc... for the subject to view during this portion of the experiment. Neutral images,
such as a single color or a blank page, will also be used.
2. Click the Record button in the upper right corner of the LabScribe Main window.
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3. While the subject is sitting quietly, begin to show the images one at a time. Pause on each image
for 3-5 seconds to allow the subject to respond to what he or she is looking at.
4. Mark the recording with either an S, F or N based on the type of image shown. Click on the
Mark button to label the recording appropriately.
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5. Repeat step 4 using at least 20 images that will elicit some sort or emotional or neutral response.
6. Select Save from the File menu.
Data Analysis

1. Scroll through the recording and find the beginning of the section of data recorded while the
subject was looking at the images.
2. Click and drag the cursors so they are placed at the onset and offset of the response to the
image.
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3. Click on the Analysis window icon in the LabScribe toolbar or select Analysis from the
Windows menu to transfer the data displayed in the Main window to the Analysis window.
4. Look at the Function Table that is above the uppermost channel displayed in the Analysis
window. The mathematical functions, Abs. Int and T2-T1, should appear in this table. The
values for Abs. Int and T2-T1 on each channel are seen in the table across the top margin of
each channel.

6. If there is no response, leave the value columns empty.
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5. Measure the Abs. Int and T2-T1 value for the response to the image shown and record the
values in either the Journal or on Table HP-1-L2.
7. Scroll through the recording and repeat steps 5 and 6 for all 20 images shown.

Questions

1. Did the subject show the expected emotional response to each of the image shown?
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2. If the subject did not shown the expected response, what explanation can be given for this?
3. Was there any variation in EMG activity or duration of the response based on the image? Why
could this happen?
4. What reasons can you give for a lengthier response?
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5. What reasons can you give for a higher or lower EMG response?
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Table HP-1-L2: Recorded Values for Emotional Images
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Image Type (S, F, or N)

Frown
Smile
Smile
Frown
Abs Int (mV)
Abs Int (mV) Time (sec)
Time (sec)

MEAN
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